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0. Introduction 
Doddle is your one-stop program to generate quality anaglyphs and stereoscopic jpegs 
for use with Andreas Petersik's Stereoscope Java Applet. It has all you need to align, 
resize and crop your stereo photograph pairs without the need for an expensive 
graphics program.  

I have used different software to create anaglyphs. None had all the features I 
wanted, like resize and rotation. And the generation of stereoscopic jpegs has always 
been a bit cumbersome. So I decided to make it a ... doddle. 
 

1. Features 
Doddle boasts the following features: 

·  Load from relevant formats  
o Load separate image files or just one that holds both images.  
o Loads images in jpeg, bitmap and jps (stereoscopic jpeg) format.  
o Swap left and right images at any time on the click of a button.  

·  Save  
o Saves analglyphs or stereoscopic jpegs  
o Saves separate image files for future work in either bitmap or jpeg 

format  
·  Alignment of the images  

o Use mouse to align images  
o Put your red/cyan goggles on to see the effect straight away  
o Mirror image  
o Rotate image 90° clockwise or anti-clockwise  
o Rotate image 180°  
o Rotate one image until it fits perfectly over the other (0.1° increments)  

·  Crop to select the area of the final image  
o Overlapping area selected for you  
o Resize overlap area by dragging the border with the mouse  

·  Resize both images  
o Resize to achieve a certain percentage or give dimensions  
o Arbitrary aspect ratio  
o Choose resample filter for quality resize  

�  Box  
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�  Triangle  
�  Hermite  
�  Bell  
�  B-spline  
�  Lanczos3  
�  Mitchell  

·  Analgyph  
o Red/cyan full colour  
o Red/cyan full colour (desaturated)  
o Red/cyan greyscale  
o Red/cyan greyscale red  

·  Advanced options  
o Choose greyscale algorithm  

�  normal red/green/blue=30/59/11 - algorithm  
�  by desaturating the image  

o Save settings like anaglyph method and resample filter 
o Shell integration  

2. Quickstart 
The aim of this quickstart chapter is to explain everything you need to know to get 
started. It will lay out the principle concepts of this program (doddle). I recommend 
you read this chapter even if you decide to learn all the details as well. 

Doddel works by holding two images in memory, the image for the left eye, called 
left image, and the image for the right eye, called the right image. 

The left image is pinned to the canvas of the program, many functions work with 
the right image only. This is not a restriction, as you can swap left and right image at 
any time.  

Now align them by dragging the right image over the left, and by rotating the right 
image until you achieve a satisfactory result.  

There will be an area now that overlaps, and it is that area that you can make a 3D 
image of. You have to select this area. Click the Crop button. A dashed line will mark 
the overlapping area. You can resize it to cut of unwanted margins, then press the Cut 
button.  

Once you have aligned your images, you can either save them into individual files 
again, or you can save them into one file, either an anaglyph or a stereoscopic jpeg.  

3. Open stereo pair images 
Your pair of photographs will either come from a digital camera or the will be 
scanned images from prints. Doddle allows you to open two images separately or in 
one go. It can also open just one file, assuming that both images are held in that file. 
This could be the case when you lay two prints onto a scanner and scan them both in 
as one file, thus keeping them together nicely. Remember that you can swap left and 
right image at any time. 



Doddle 1.1 User Manual, Rev 1.0, © 2006 by Cushat - 4 - 

 
The options should be obvious. Open the left and right image separately, or open 

both images in one go. There is a short-cut for the latter option, Ctrl-O. Alternatively, 

press the Open Both Images-button . If you use this function, you can select two 
images in the dialog. Click on the first image, then hold the Ctrl key down and select 
the second image.  

Remember you can still swap the images once they are loaded. This is done with 
the Edit/Swap function, the short-cut Ctrl-W or the swap-button . 
If you have both images in one file, use the Open Both Images function and select just 
this one file.  

The image will be loaded as the left image, and it will be loaded again as the right 
image. All you have to do now is align the images properly. 

4. Align images 
The images are aligned by moving the right image over the left image until you are 
happy with the result. To do that you click inside the image with your mouse and hold 
the mouse button down while you move the image around.  

You can check the result straight away by setting the view mode to anaglyph and 
putting your red/cyan goggles on. 
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You can always switch back to full colour mode or another anaglyph mode once 

the images are aligned properly. Remember the original images you have loaded have 
not been changed. 

Another thing you can do in terms of alignment is rotate the right image. Select 

Rotate from the menu or press the rotate button  . Alternatively, use the short-cut 
Ctrl-R. You will be prompted with this message: 

 
Select a rotation centre by clicking with the image on the point you would like the 

right image to rotate. Once you have done that, a slide bar appears on the top of the 
image. Slide left or right to rotate clockwise or anti-clockwise.  
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If you prefer you can use PageUp and PageDown to change the angle by 1°, or 
use the Left and Right keys to change the angle by 0.1°. 

Once you are happy with the result, press the  button to commit to the rotation. 
To cancel, press the   button, which will take you back to the standard mode . 

 
If you click on Edit Right you will see that there are functions to easily rotate you 

right image by 90°, 180° and 270°. 

 

There is also a Mirror function and a mirror button  , short-cut is Ctrl-M. The 
functions under the Edit Right menu apply only to the right image. This is no 
restriction, as you can swap your images on the click of a button. 
 
� � : The Edit Right functions will actually alter your right image.  

5. Select area of final image 
You have now moved the images around to overlay them properly. You can only 
make the jps or anaglyph from the area where the images overlap. Before you can 
save an anaglyph or jps, you have to select this area. That is as easy as it can be. 

Press the crop button  or select Crop from the Edit menu. This will outline the 
maximal overlap area in a dashed line: 

 
You can now drag and resize this dashed rectangle like a rubber band. Of course, 

you can’ t make the area any bigger. If at any point you like to go back to the maximal 
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overlap area, press the max button . To crop both images, press the cut button . 
All these function are also available on the Edit menu. If you think you should go 
back and re-align the images before committing to a crop, press the cancel button . 
The rubber band will disappear, and you are back in the standard mode. Re-align and 
do the crop. You have to crop in order to be able to save the images. 
 
� � : The Crop function will actually alter your images.  

6. Resize image 
While this is not necessary, it might come in handy to be able to resize both images. 
Digital cameras have a resolution much to high for web pages for example. It is 
recommended that you align, rotate and crop your images before you resize them. It 
might also be a good idea to save the result of your alignment efforts before you 
decide to resize. See the next chapter for the save options you have got. 

To resize, select Edit/Resize or press Ctrl-Z or the resize button . You find 
yourself faced with this dialog: 

 
You can see the original dimensions of the left and right images. You can change 

width and height of the left image, but not those of the right image. Those will be 
adjusted automatically, assuming you want to resize both images by the same factor. 
Further you can choose whether to specify the new size in absolute pixels, or as a 
percentage.  

You will have noticed the lock-aspect-ratio check box. If that is checked, changes 
in width will automatically adjust the value for height, and vice versa. If you give a 
percentage, entering it into one box will then suffice. 

To change width and height independently from each other, untick the lock-
aspect-ratio check box. 

The last option to explain is the resampling filter. Without going into details here 
just a few thoughts to explain the process. I assume we want to make our images 
smaller, not bigger.  
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When resizing an image to say 25%, you could just take every fourth row and 
every fourth columns. That would make your image 75% smaller. This method is very 
crude. When resizing an image you will always loose some information. But surely 
there must be better way of doing this? Resampling is a method by which 
neighbouring pixels are taken into consideration as well. A special algorithm called a 
filter id applied to a field of neighbouring pixels to compute the resulting pixel. How 
this is done is determined by the resampling filter.  

Looking at an area of pixels takes a bit longer, so resampling takes time. In the 
status bar of Doddle you can see the time for each rotation in milliseconds. This is for 
information only. See the graph below for a comparison of the resampling filters in 
term of speed. 

So which one should you use? The answer depends on the nature of your image. It 
is best to experiment. Note that Box and Triangle are not only the fastest, they are also 
the poorest quality-wise. 

Box

Triangle

Hermite

Bell

B-spline

Lanzcos3

Mitchell

Resampling time

90%

60%

30%

 
The graph above shows times for the different filters when resampling a 

2550x1817 image to 30%, 60% and 90% of its original size. 

7. Save image as anaglyph or as stereoscopic jpeg 
This might be a good place to say something about what a jps or stereoscopic jpeg is. 
A jps is nothing more than a jpeg holding a pair of stereo images in full colour 
arranged for cross-eyed viewing. The two images have the same dimensions. There is 
software around that uses this format.  
If you have a jps you can easily view it cross-eyed, or use the two images to create 
anaglyphs. 

Doddle gives you the option to save to jps for two reasons. One is to have them 
ready for software that expects jps, the other is so you can store and archive your  
photograph pairs without losing any colour information, as you would with 
anaglyphs. 

Another good way of storing your perfectly aligned pairs of photographs is to save 
them separately. Doddle can do that as well. When you photographs are aligned, 
rotated and cropped, save them before resizing. That way you have kept a perfect set 
of images for future use. Only then resize to your present needs, like web publishing. 
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When using the Save Both Images option from the File menu, which is the same 

as pressing the save button  or Ctrl-S, you will either save to anaglyph or jps 
depending on you viewing mode. Select Full colour as viewing mode, and you will be 
expected to save as jps. 

 
Select any anaglyph mode, and you will be expected to save an anaglyph. 

 
Note that anaglyphs can be saved as jpegs or bitmaps, whilst jps are always jpegs. 

8. Advanced options 

Open the options dialog with the menu option option/options or press the  button. 
This will dialog will pop up: 
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Saturation 
If you choose Red/cyan full colour (desaturated) both images will be desaturated 
before they get converted to anaglyphs. Set saturation to control how much you want 
to desaturate, A value of 60 means desaturated to 60% of the original. 

Compression Quality 
As you know, jpegs are compressed images. To be me more precise, the format 
specifies a lossy compression. When saving to a jpeg or jps (which is nothing but a 
jpeg), you will loose quality. By setting CompressionQuality you can determine the 
quality of the image. Choose a low value of quality to get smaller files, or choose a 
larger value to save good quality jpegs that are somewhat larger. 

Anaglyph modes 
You will be wondering what all the anaglyph modes are. Here now an explanantion. 
But first the full colour mode used for jps generation.  
 
1. Full colour jps 
This is simply a jps with the two images you provided as the stereo pair. 
 
2. Red/cyan full colour  
All green and blue is removed from the left image. All red is removed from the right 
image. There is some colour information preserved in these images. 
 
3. Red/cyan full colour (desaturated)  
Same as full colour, but the images are desaturated first. Default is 60, i.e. the image 
will be desaturated to 60% of the saturation of the original image. Sometimes, this 
yields anaglyphs with more detail. 
 
4. Red/cyan greyscale  
The left and the right images are converted to greyscale images, but the green and 
blue values or set to zero for the left image, and for the right image the red value is set 
to zero. The anaglyphs created in that way are clear and easy to view. However, all 
colour information is now lost. 
 
5. Red/cyan greyscale red  
The left image is a greyscaled red, the right image is the original right image with all 
red removed. Often easier to view than full colour, and not quite as colourless as 
red/cyan greyscale. 
 

Resampling filter 
Set your preferred resample filter. See chapter 6. Resize image for details. 

Greyscale by desaturation 
Next item on the Options menu is Greyscale by desaturation. What does it mean? 
First, let’s have a look at how you convert to greyscale normally. 

As you know, on your computer screen each colour is made up of a red part, a 
green part and a blue part. This model is called RGB. In truecolour each part has a 
value between 0..255. It turns out that 50 green seem much brighter to the human eye 
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than 50 red, and that again is perceived as much brighter than 50 blue. This perceived 
brightness is called luminance, and to achieve the same luminance in the greyscale 
image, the following formula is commonly used  

 
luminance  = 0.3red + 0.59green + 0.11blue1 

 
This gives a good representation of the luminance in the original image. However, 

sometimes two different colours can have the same luminance and so will become 
indistinguishable in their greyscale representation. Take this painting by van Gogh: 

 

     
 
In the greyscale, the stars have all gone. What happened? The colours have a very 

similar luminance, and are represented by a similar grey value.  
It is for that reason that I have provided a different method of greyscaling. You 

have the option to have greyscaling carried out by desaturation. In colour theory, 
saturation is the intensity of a specific hue, or in other words the purity of a colour. To 
get a purer red, for example, one could increase the red part of the RGB triple and 
decrease the green and blue values. You would get the same colour, but more leaning 
towards the red now. To desaturate means to decrease the dominance of a colour in a 
RGB triple. By greyscaling by desaturation I mean to desaturate to the point where all 
three values are the same, i.e. have a grey value. 

Let’s desaturate the van Gogh, first to 60%, then to a complete greyscale: 

                                                 
1 William K. Pratt, Digital Image Processing, John Wiley & Sons, New York, 1991. 
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In the left image you should see how the colours become less dominant. On the 

right image you should see the stars.  

Expert mode 
When set this switches all confirmation boxes off. This is handy if you know what 
you are doing. At first, leave it off. Later, when you have used Doddle for a while and 
feel confident, tick the box. 

Save Settings on Exit 
Tick this, and all settings are saved in the INI file for the next time you start Doddle. 
This includes the anaglyph mode and resample filter you have last used.  

Shell integration 
The following are options that control the integration of Doddle and the jps file format 
into the windows shell. Changes to any of these options take immediate effect, and a 
message box will remind you of that before the changes are made. 

·  enable jpeg context menu 
tick this box and jps will have the same context menu as jpg 
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·  add Doddle to context menu 
tick this box to add Doddle to the context menu of jpgs and jps, selecting 
Doddle from the menu will open the image in Doddle for you. 

·  enable thumbnail preview 
this will register the JpsShellExt.dll shell extension with regsvr32. 
JpsShellExt.dll provides a preview for stereoscopic jpegs (jps) in windows’  
thumbnail view. Jps files consist of two images, JpsShellExt.dll only shows 
the left image to make optimal use of the small preview area: 

 

 

Save Settings Now 
Select Options/Save Settings Now to save the settings immediately. This is how you 
preserve the settings and selections you have made. The other way the settings are 
saved is by ticking the Save settings on exit box in the options dialog. 


